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> Please note, the above TOC is for Print so includes Page Numbers. Take care to Customise your TOC for ebook.
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I've created a section dedicated to the Table of Contents (TOC) because it can throw up
unforeseen challenges when you are uploading to your chosen ebook platform.

There are a couple of ways to create a TOC, but the method you chose is dependent on the
retailer/platform you are uploading to. There is the Amazon Method and then the
‘Everybody Else’ Method.

Introduction

It's wise to have a TOC at the beginning of your book regardless of whether you are
writing Fiction or Non-fiction, primarily because your audience will appreciate it. It
improves, usability, improves the user experience and it provides a useful overview
of what’s actually included in your ebook. It’s also good for you as the author
because you can include a link to your Bio or a link in the TOC to other books you
have written.

So —we’re in agreement, TOC's are good to have.

Now, there are two ways you can create the TOC. One is specific for the Amazon
Kindle, and the other is an all-encompassing method that will work at any retailer.

Amazon - Kindle

This method relies on using the Heading 1, Heading 2, Heading 3, settings in
Word using the References tab and the Inserting TOC feature.

I’m assuming you have your Word file open in front of you.

Scroll past your title page, your copyright, and your dedication (if you have one).
Type out the words — Table of Contents

This is where your TOC will appear

Hit Enter (return)

Insert Page Break

This will ensure your TOC has its own page.


https://www.facebook.com/mcraecomms/

Facebook: https://www.facebook.com/mcraecomms/ 4

M |1 - 5 &=

Insert Design Layout References

| == 1 - 1
= z| = == Add Text - . AR, Next Footnote
= = -A-B ] [ I ] >
Table of 2= Update Table Insert Insert Show Motes
Contents Footnote Endnote
" 2 1 2 e it 5 5 7 a8 £

14

el

Once you have allocated a TOC page up you can now go through and Highlight your
main headers/chapter heads as Heading 1

| am going to select Example 1 and assign Heading 1 status to it so you can see, and
Example 2 will be given Heading 2 status so you can see the difference

Ee ||AaBbCcDell| AaBbCcDdEe AEBb{ AaBbCcDdEe  AaBbCcDdEe |2

ig Heading 1 Heading 2 Titla Subtitla Subtle Emph.._
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Example 1

Example 3

The heading levels can be modified to any font or size you want. All you have to do is
‘Update to Match Selection’ or ‘Modify’.

Work your way through your document, assigning all your headers, chapter heads,
sub heads and so on, with the level of Header 1, Header 2, or Header 3. Remember
to always use the References Ribbon and not simply using text Styles.

Once you have gone through your document you are ready to insert the TOC back at
the beginning of your document.

Click the paragraph return, and now use the References tab to Insert a TOC.
Rather than select one of the TOC’s already prepared for you, you can select a
CUSTOM TOC (located at the bottom of the list depending on your version of Word)
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Custom

Under the CUSTOM header you should uncheck any box that says Show Page
Numbers. We do not use page numbers in ebooks — think more about your ebook in
terms of computer screens rather than a traditional book.

Next you should select a format that fits in with the look and feel of your ebook.
Underneath the Formats box you will see Show Levels. Make sure that reflects the
number of Headers you want, or the number of Headers you have assigned in your
content.

TR W Sl ISR D

ndex able of Contents Table of Figures Table of Authorities

Formats:

From template Heading 1
Traditional Heading 2
Classic

Contemporary

Farmal

Simple

-~

Show levels: |2 2

Show page numbers

L4

v | Right align page numbers Tab leader: ...

Options...

Cancel

Once you have set up the look of your TOC you are now ready to click OK.
Everything that you assigned as a Heading 1, Heading 2 and/or Heading 3 setting will
appear in your TOC.

These are actually active hyperlinks. If you put your cursor over it, and for PC users,
you click control and then click, you will be taken to that location.
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Bookmark

It's called a TOC bookmark, and this will provide your Kindle readers with a menu
option to go straight to your TOC no matter where they are in the ebook.

Put your cursor in front of the TOC you’ve typed
Click the Insert tab, and find the Bookmark tab
Type in the letters TOC in the Bookmark Name box
Click ADD

.
E:_,Z ) & i S

b eclia Hyperlink Bookmark Cross-reference Comment
Bookmark

Bookmark name:

TOC
|
|
|

Sort by: ) Mame " Location

Hidden bookmarks
 Add Cancel

You can then go through all your chapter headers and add a bookmark linking to
TOC, so that if your readers click on the headers they will automatically be taken
back to the TOC.

Then Save your document

If you want to make additional changes in your copy that will affect your TOC that’s
absolutely fine. Perhaps you want to change the name of one of your headers or
perhaps you want to change the Heading Level? Make your changes as normal then
right click and update field (or entire table). You may also be able to use the F9 key
to update, however, in Mac this doesn’t seem to work.

And this is how you create a TOC specifically for your Amazon ebook. You may find
this technique works on some of the other retailers but | can’t guarantee it, so for
simplicity think of this approach for Amazon, but a Universal approach follows.

Hidden Bookmarks
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One you have set all your useful Bookmarks there is one last step you must follow. | warn
you upfront it’s a particularly tedious task but it's one you can’t get around. When you are
creating Bookmarks, for some reason Word likes to add its own hidden bookmarks. The
nuisance is, if you don’t get rid of these hidden bookmarks before you upload your ebook to
your chosen platform, they will create all sorts of merry hell for your formatting. Think of
them as invisible gremlins pushing your lovely text to the wrong side of the page or
capitalising random pieces of text. You don’t want them, so here’s how to spot them and
get rid of them.

Go to Insert on your Ribbon
You’ll see Hyperlink, Bookmark, Cross Reference
Select Bookmark

Bookmark
Bookmark name:

themagicofmetadata

themagicofmetadata
TOC

Sortby: @) Name Location
Hidden bookmarks

Adld Delete m Cancel

At the bottom of this box you can see an unchecked box beside Hidden bookmarks.

Tick/Check the Hidden bookmarks box ... and you will see a long list of bookmarks
you did not create. These are the hidden gremlins in your formatting.
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Bookmark

Bookmark name:
themagicofmetadata

_Toc486606012
_Toc486606013
_Toc486606014
_Toc486606984
_Toc486606985

Sortby: @ MName [ Location
Hidden bookmarks

Add Delete Close

Unfortunately, there is no quick or painless way to get rid of these. You will have to
go through and individually select each one and delete them until they are all gone
(leaving the ones you have created).

TOC on Word for Mac — meet Amazon

If you go to the Kindle support page on Amazon, you will see many threads about getting a
clickable TOC to work on Amazon — so let me save you the trouble of trawling through these
pages.

If you are using Word for Mac you will find when you create a TOC that the elements are not
live/or clickable. Therefore, you need to do this manually.

So either (a) type out all of your chapter headers or subleaders under the words Table of
Contents (at the start of your ebook as we have already discussed) or (b) go through and
assign Header levels as you would in the Amazon method. Either way, you want to end up
with a list of headers at the front of your ebook.

Now go through the contents of your ebook and Highlight Chapter 1 and assign Heading 1
to it (from the Home Style Pane), Chapter 2 (Heading 1) and so on. Assign the Heading level
according to the level you want in your TOC.
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When inserting your Hyperlink make sure you have selected ‘This Document’ so you can see
Headings or Bookmarks

Insert Hyperlink

Text to Display: ScreenTip...

Web Page or File This Document Email Address

Select a place in this document:

Top of the Document
k- Headings
- Bookmarks

Cancel

- =
Open up Headings and you will see the headings you have already created.

Insert Hyperlink

Text to Display: ScreenTip...

Web Page or File Email Address

Select a place in this document:

Top of the Document
¥ Headings
Table of Contents
P Introduction
P Example 1
> Bookmarks

Cancel

Now once you have gone through all your copy, go back to your TOC page and select each
chapter head, then add Hyperlink

Save to HTML
You then need to save as HTML —
Save as Web page (htm)
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This is the file that can be saved to Kindle — Amazon Kindle will convert the htm to a MOBI
clickable format

Et voilal

The ‘Everybody Else’ (Manual) Method

| also want to explain another method of creating a TOC, and | call it the ‘everybody
else’ (manual) method because it works at every major retailer.

In order for your TOC to work across other retailers you will have to:

e Manually type out the titles of your chapter headers under your TOC heading
at the beginning of your book. (So no hyperlinks will appear when you hover
over the text)

e Then you will go into the body of your ebook content, to the desired headers,
and Insert a bookmark (as we did in the Bookmark method on Amazon). So if
your chapter header is called ‘The Magic of Metadata’ you need to type
themagicofmetadata (without spaces) in the Bookmark box which appears
after you Insert Bookmark. If you must include ‘spaces’ use a dash or an
underscore as follows: the_magic_of metadata / the-magic-of-meta-data.

e Once you have created the bookmark you need to come back to your TOC and
create and highlight The Magic of Metadata, then add a hyperlink at the
corresponding place in the document (linking it back to the bookmark you
have created).
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Insert Hyperlink

Text to Display: | The Magic of Metadata ScreenTip...

Web Page or File | This Document | Email Address

Select a place in this document:

Top of the Document
¥ Headings
Table of Contents
» Introduction
bk Example 1
¥ Bookmarks
themagicofmetadata
TOC

Cancel

Once you have gone through creating Bookmarks and hyperlinks, your readers can
now automatically go to any location they wish location.

NCX File

Further to this, if you plan to upload to Smashwords, there's something called an
NCX file, which is Navigation Control.

In simple terms this is ‘labelling’. The labels have to appear exactly as they appear in
the TOC as they do anywhere else in your document. For example, say you want to
Hyperlink Chapter Two using the word "two" in your TOC, then, when you go to
Chapter Two in your document, you could go to Chapter Two and you could type it
out as Chapter 2 as a number, and you could still make a manual hyperlink that work.
(It’s not best practice but it will work). However, during the conversion process for
Smashwords (Navigation Control), the NCX file won’t be converted properly because
it won’t recognise the label. So it's really important to spell these things exactly the
same in the TOC as at the location in the text that you want it to go to. So at this
point you've got two methods for creating a TOC, one specifically for KDP

Amazon, and another for Everybody Else (Manual).
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Conclusion

Once you have mastered creating your TOC in the 2 very distinct formats you should work
through these with ease for your future ebooks. The most important piece of advice | can
give you is to make sure you test every single hyperlink and bookmark. As | said, it can be
tedious but if you want a quality ebook that your audience loves, then keep them happy
with a little bit of hard work up front.

If you are still struggling with TOC’s and clickable content, just send over an email and I'll see
what we can do.
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